
In the process of making videos or multimedia
presentations children learn how to do research, to
conduct interviews, to write a variety of styles, to
work collaboratively, to make informed decisions
and give oral presentations – the list goes on.  And
because it is produced for an audience – whether
sitting in front of a TV in the classroom or on the
World Wide Web – the work feels authentic to
students, in ways that typical “schoolwork” often
does not.

Educators recognize the value of projects as tools
for teaching and learning, as evidenced by the
New York City Board of Education’s 8th Grade Exit
Projects in Science and Social Studies.  Among
the mediums available for creating such projects
video is certainly one of the most exciting.
This guide,  prepared for the New York City Board of
Education’s Office of Instructional Technology,
provides a brief introduction to creating classroom
media productions. It offers a basic introduction to
Hyperstudio and iMovie.  To create the video clips
and still images for the Hyperstudio projects we
used the Mavica camera because it allows for the
creation of short video clips right on a standard
computer disk or CD-R.  We also provide some
ideas for assessment of media projects, including
several rubrics which can either be used as-is or
modified. We usually develop rubrics with our
students because it encourages them to reflect upon
their learning and allows them to have input into the
evaluation process.
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In the process of making
videos or multimedia
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interviews, to write a variety of
styles, to work collaboratively,
to make informed decisions
and give oral presentations

– the list goes on.  
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GETTING STARTED : FIRST STEPS

USING A VIDEO CAMERA
It’s not hard to learn to operate video equipment. A
camcorder is user-friendly, a lot like a car. Most of us
don’t know how a car works but we can drive one
with no problem. All we have to do is get over our
initial fears, read the manual and practice. From
there on, it’s easy. There’s only one problem with
video equipment, as with a car - once you teach your
kids how to use it you’ll have to fight to get your
hands on it again. And you must stress safety; tell
students never to leave a video camera on the edge
of a table or unattended.

These are the essential features to outline:         

• Power Button • Inserting Tape    
• Holding the camera • Internal Mic
• Charging Battery             • Record/Pause
• VCR/Camera Function  • Zooming In/Out

PLANNING YOUR SHOTS
In order to produce a video project, some time needs
to be given to learning about basic camera operation
and camera shot language terminology.  Practice the
different shots and camera movements from the Shot
Sheet.  When you are ready to shoot your video,
decide what type of setting, shot and camera
movements you are going to include.  Use the
storyboard handout to plan this:  

What environment do you want to use, and what
background do you want to see? 

A particular setting can immediately tell your viewer
something about the interviewee or protagonist -
whether it is an office, a  classroom, a hospital, a
home, a park, etc.  

What kind of shot do you want to start with?

If you are shooting interviews, do you want to see the
interviewer, or just the interviewee?

Keep in mind that even if the audience doesn’t see
the interviewer, they will hear the interviewer, so the
audience will be aware of all of the interviewer’s
questions and comments.  Some video producers
start with a wide shot where the audience will see the
interviewer, interviewee, and the environment that
the interview takes place in.  You can plan your shots
using the Shot Sheet and Storyboard Sheet in this
packet.

USE A TRIPOD
In order to avoid a shaky shot, it is best to use a
tripod.  Think about the angle that you want (refer to
the shot sheet) and set the tripod to the proper
height.  If you set the tripod to its maximum height,
you will probably get a high angle shot.  If you want
an eye-level shot, start with the legs low, even the
shortest leg-length possible and adjust the tripod
height up and down with the handle.  

If you don’t have access to a tripod, keep in mind that
the closer your shot is, the more the camera shake
will be noticed.  If you are shooting without a tripod
and you want to avoid shaky shots, try shooting wide
and medium shots and avoid close-ups.  

Of course, nowadays hand-held, sideways and even
upside-down shots are used in music videos and
mainstream TV, so you may choose to shoot without
a tripod.  The key word is intention... if you are
getting shaky shots, make sure that is what you are
going for.

TIP: If you have to shoot into a light, zoom in on
the subject as much as possible to shoot a close
up.  This will minimize the light in the background
and therefore minimize the backlight effect.  

AVOID SHOOTING INTO A LIGHT
SOURCE
Shooting any camera into a light source like the sun
will silhouette the subject.  This is called the backlight
effect.  To avoid this, never place the subject in front
of a window or bright light.  Sometimes even placing
the subject in front of a white wall will have the same
effect.  The camera light meter reads the amount of
light on the white wall, or the sunlit sky as too much
light and it automatically shuts down the iris to
decrease the amount of light.  As the light meter
cannot decrease light on the background without
decreasing it on the subject as well, the subject often
ends up poorly lit and even silhouetted. 

A camcorder 
is user 

friendly, a 
lot like a car.
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USE AN EXTERNAL MICROPHONE
For most school projects, using the camera’s built-in
microphone will be inadequate.  If you are shooting
interviews, it is difficult to get the camera close
enough to the subjects for the volume to be high
enough.  Often there are street noises or loud school
background noises that will compete with the
subjects’ dialogue.  With skits, assemblies, speakers
and other performances that involve an audience, it
is also difficult to get the camera close enough to
those being videotaped.  

Almost all video cameras have a small microphone
input—usually a “mini” input, which a microphone
cable will plug right into.  Most microphones have a
three-pin XLR connection (microphone-male, XLR
connection-female) and  a male XLR to male mini
cable will attach the microphone to the camera.  
(See Figures 1-1 and 1-2)   

With an external microphone, the sound quality will
be vastly improved.  The street and school sounds
that were so distracting before will now only add
character and a sense of environment to your
videotape, without  rendering the  talents conversa-
tion inaudible.   

Depending on the microphone’s pickup pattern, the
direction the mic is pointing could be very important.
A unidirectional mic will ONLY pick up sound in the
direction it’s pointing in, while an omnidirectional mic
will pick up all sounds nearby, regardless of where
the mic is pointing.  It is safest to point the mic in the
direction of the person talking, 6-12 inches from
her/his mouth.  

When the interviewer asks a question or makes a
comment, the mic should be pointed toward her, and
when the interviewee answers, the mic should be
gently tilted away from the interviewer and toward
the interviewee.  We suggest that the interviewee
always hold the mic in order to control these slight
but very important mic movements.  

Lastly, remember to always use headphones to
monitor your sound.  Look for the headphone input
on your camcorder (usually a “mini” input).  Even
Walkman headphones will do.  

If you don’t get sound in the headphones STOP: you
will not be recording sound on your tape!  Check
your microphone; it may be switched to “off”, or the
batteries may be dead; check your cable - it’s good
practice to always have a spare cable as a backup.
Finally, check your headphones; you can do this by
unplugging the external mic and check to see if you
hear sound through the headphones when using the
camera mic, which is more likely to be working.

TIP: Mic cables and inputs are fragile.            
Be careful not to step on mic cables or exert 
pressure on the mic input on the camera.  Once
the mic input on the camera loosens - the mini
jack connector will not fit snugly into the plug    
which means you will have difficulty recording 
sound successfully using an external mic.  
Unfortunately, a loose external mic connection is 
an expensive repair so you want to avoid it.

Figure 1-1
XLR Plug 

Figure 1-2
Mini Plug

GET YOUR EQUIPMENT & STUDENTS
READY
Before you introduce your students to the
equipment, be sure to charge your batteries fully and
test all your equipment and cables. Nothing is more
frustrating than having a classroom full of eager
faces and a desk-full of  inoperable equipment.  It is
important that your students learn how to operate the
camera and  get used to working in their crews, so
always allow at least one practice session before the
real shoot. 

With an external
microphone, the
sound quality will
be vastly improved.

TIP: A camera typically takes a few seconds to 
begin recording once the record button is 
pressed.  To avoid missing anything, be sure    
to start recording at least 5 seconds before an 
action begins.  This is why the director  says  
"Roll Tape”, then counts down 3 seconds before
saying “Action”. 
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STORYBOARDS
Creating a storyboard is a good way of ordering your ideas for how a video might look.  It usually takes the form
of a series of blank boxes with space underneath to note down the type of shot you want to record, the action that
occurs and what sound will be heard.  Below is a sample storyboard from the “EVC YO-TV Production Handbook”.
We have included a storyboard template for you in this guide that you can print and use with your students.  

ROTATING CREW ROLES 
At EVC, we have students rotate crew roles
frequently, so that even within one shooting session
several students get a taste of the different jobs on a
crew. This way  more students have the opportunity
to actively participate in the class and to try each
position on the crew. We have found that without
crew role rotation, students tend to gravitate to one
job and never try another; they do that which is
easiest for them, and lose the chance to find a
hidden talent  such as public speaking or operating
the camera.  How often you have students rotate is
up to you.  When shooting a skit, you might have
students rotate crew roles with every shot change.
In an interview situation, the rotation can occur after
every interview segment or less frequently,
depending upon how much time you have.  Refer to
the Crew Roles & Responsibilities sheet we have
included for you in this guide, for a description of the
different roles you can assign your students. 

TIP: When using an external microphone    
(especially when taping interviews or narration),
the director can stand right next to the camera
person and quietly whisper directions.  This way
the director can call the shots without being heard
on the video tape. 

At EVC, we have students 
rotate crew roles frequently, 
so that even within one 
shooting session several
students get a taste of the
different jobs on a crew.

WIDE SHOT: Boy
walks down path

MEDIUM SHOT:
Boy sees girl

LONG SHOT: Girl
walks down path

MEDIUM SHOT:
Girl sees boy

CLOSE UP:
Boy and girl meet
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STORYBOARD

SHOT:

ACTION:

AUDIO:

SHOT:

ACTION:

AUDIO:

SHOT:

ACTION:

AUDIO:

SHOT:

ACTION:

AUDIO:



DIRECTOR:
The director organizes the set, decides where to put the camera, lets the camera operator
know how the shot should be framed and decides when to start/stop shooting.
At the beginning of a scene or interview the director says:

• Is the camera ready?  (Camera person answers yes or no)
• Is the sound ready? (Sound person answers yes or no)
• Is the talent ready?
• Quiet on the set!
• Roll camera (camera person starts recording)
• 5, 4, 3, 2, 1…..(talent gets ready)

Action!  (talent starts talking)

At the end of the scene or interview, the director says:

• Cut! (camera person stops recording)

CAMERA PERSON:
The camera person sets up the camera and shoots the scene.
When the director says, "Roll camera,"  the camera person presses the record button.  When
the director says, "Cut,"  the camera person stops recording.

SOUND PERSON:
The sound person sets up the microphone and monitors the sound using the headphones.  If
the sound is inaudible or there are sound interferences, the sound person signals or whispers
to the director, who will yell,  "Cut!"

TALENT:
The “talent” are the actors,  interviewers, interviewees, narrators or reporters in a skit, docu-
mentary, or news show.  They start speaking or moving when the director says, "Action,"  and
they stop when the director says,  "Cut."

NOTE TAKER/SCRIPT SUPERVISOR:
The note taker jots down observations on each take of a given scene or shot.  They note
down misspoken lines or lines said particularly well.  Additionally, they identify what they
believe to be the best take or the best "bite" or portion of an answer in an interview.  This will
help in the editing/decision making process on what to include in the final video later on.

SCOUT:
While shooting interviews, the scout will try and line up several interviews so that when an
interview ends, the next interviewee is ready to go.

OTHER CREW ROLES:
If there are students left working in a group that need a crew role, the following roles can be
assigned: Assistant Director, Assistant Camera person, Prop Person, Production Manager.

CREW ROLES & RESPONSIBILITIES



Shot /Scene# _____

Talent: _____________________________________________________________

Director: ______________________    Camera person: _____________________  

Sound person: _________________ Notetaker: __________________________

Shot /Scene# _____

Talent: _____________________________________________________________

Director: ______________________    Camera person: _____________________  

Sound person: _________________ Notetaker: __________________________

Shot /Scene# _____

Talent: _____________________________________________________________

Director: ______________________    Camera person: _____________________  

Sound person: _________________ Notetaker: __________________________

Shot /Scene# _____

Talent: _____________________________________________________________

Director: ______________________    Camera person: _____________________  

Sound person: _________________ Notetaker: __________________________

Shot /Scene# _____

Talent: _____________________________________________________________

Director: ______________________    Camera person: _____________________  

Sound person: _________________ Notetaker: __________________________

ORGANIZING THE SHOOT



MAVICA MULTIMEDIA
PRODUCTION WORKSHOPS

As mentioned at the start of this guide: in the process
of making videos or multimedia presentations
students learn how to do research, to conduct
interviews, to write a variety of styles, to work
collaboratively, to make informed decisions and give
oral presentations.  Recognizing this, The Office of
Instructional Technology arranged for the
Educational Video Center to provide professional
development for teachers on the use of the Sony
Mavica camera and  the multimedia presentation
program, Hyperstudio through the “Mavica
Multimedia Production Workshops”.

Participating teachers were provided with research
materials on the subject of immigration (as an
example of what could be studied) so that they could
develop an essential question or problem, and then
plan, shoot and edit a short project that addressed it.
This served as a model for teachers to follow when
they returned to their classes to facilitate projects
with their students.  Teachers learned how to guide
students through the process of planning, imple-
menting and assessing short technology-based proj-
ects.  As teachers engaged their students in this ini-
tiative they would practice using digital media to for-
mulate a question, research, gather and organize
information, and present their findings.

CHOOSING AN ESSENTIAL QUESTION
The purpose of an essential question is to focus our
thinking on a topic or curriculum.  It should force us
to think about what it is we want to say and do and
keep us on track.  

An essential question should stimulate thinking and
discussion and encourage thinking outside the box
and consideration of other points of view.  

An essential question can have more than one
answer, can promote learning and may even lead to
social action. 

The purpose of an essential
question is to focus our thinking

on a topic or curriculum.  It
should force us to think about
what it is we want to say and do

and keep us on track.  

An essential question
should stimulate thinking and
discussion and encourage
thinking outside the box and
consideration of other points

of view.  

An essential question can have
more than one answer, can

promote learning and may even
lead to social action. 

The immigration-themed activities/handouts on the
following four pages (Scavenger Hunt, Creating
Questions for Street Interviews, Choosing and
Developing an Essential Question and Mapping Out
an Essential Question), were used by teachers in the
Mavica Multimedia Production Workshops and can
be used as templates for students to follow in
structuring their own projects.  Teachers should use
the rest of the guide as a resource covering indepth
interviewing skills (whether they are using a digital
still camera such as the Mavica which takes short
two minute video MPEG clips, or a regular digital
video camcorder),  the different types of camera
shots to explore, classroom management techniques
and assessment methods.
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SCAVENGER HUNT

As a group, you will go on a scavenger hunt using your Mavica camera.  You will try to
capture still images and video clips.   Here is a list of the things that you should bring back
from your hunt:

Still images

• A piece of clothing from another country or culture 
• Money from another country
• A symbol or image from another country that has been Americanized
• 2 pictures of an ethnic restaurant
• Something written in a language other than English (and its translation)
• A religious artifact

Video

• Interview 2 recent immigrants and find out why they came to America
• Record someone who will sing the national anthem of another country 
• Record how to say hello or goodbye in 3 different languages
• Record a love song from another country

Remember…

If you have the Mavica FD90:  

• you can record only 1 minute of video on each disk.
• For the still images, make sure that you select 640X 480 for image size so you 

have do not fill you disk too quickly.  
Go to Menu, click on File > Image Size > select 640X480.

• In order to record 60 seconds of video, set the image size to 160X112.  
Go to File> Image Size> 160X112.

If you have the Mavica CD 200:

• you do not have space limitations but by recording smaller images you 
will be able to fit more on the CD - refer to you manual for image size specifications.



CREATING QUESTIONS FOR 
STREET INTERVIEWS

1. As a group, discuss whom you would like to interview in the street and why 
(e.g. age group, gender, ethnic background). 

2. Have each member of the group write 3 questions that they would like to ask in your 
street interviews.  

3. Share all your questions.  

4. As a group, select 6 questions from this new list of questions 
(Note: you might need to eliminate redundant questions or to reword some questions) 

5. Order the questions from the most general to the most specific. 

QUESTIONS:

1) _________________________________________________________________________

2) _________________________________________________________________________

3) _________________________________________________________________________

4) _________________________________________________________________________

5) _________________________________________________________________________

6) _________________________________________________________________________



CHOOSING AND DEVELOPING AN
ESSENTIAL QUESTION

1. As a group, review all the material you have collected from your scavenger hunt.

2. Based on your initial exploration of the topic, is there anything that you would like to
learn more about? (each member of the group should write down a least 3 questions).

3. In your group, go around and share two questions that you would like to explore in 
a project.

4. Are there similar questions that come up?  
Eliminate questions that are redundant or impractical and combine similar questions.

5. Read your questions again.  Choose one question from the list that your group would 
like to explore.  This will become your “Essential Question”.

6. Once you have your Essential Question, map the different topics/and or questions 
related to it. 

(Note: use the mapping out questions diagram on the following page as a guide.) 
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USING THE MAVICA FD90

Flash

Shutter Button

Zoom Lever

TURNING IT ON

Slide the power switch to the right to turn on the power.  
A green light turns on.  
Insert a floppy disk into the floppy drive until you hear it click.

TO RECORD STILL IMAGES

Still images are recorded in JPEG format.

1. Set the PLAY/STILL/MOVIE selector to STILL.
To record 30 images on a floppy disk go to the menu, click on File>Image Size, select 640x480.
A 1024x768 Image size will only record 10 images on a disk.                                               
The higher the Image Size (resolution) the more space it takes up on a disk. 

2. Zoom in and out according to how you want to frame your picture.
3. Press and hold the shutter button halfway down and check the image.
4. Press the shutter button fully down. 

The shutter clicks and the image is recorded onto the disk.

Built in Microphone

Auto/Manual Focus Switch

Audio (Mono)/Video Out Jack

DC In Jack
(for AC Power Adapter)

Floppy Disk Eject Lever

Floppy Disk Slot

Battery 

Volume +/- Button
(for playback only)

LCD Backlight Switch

Play/Still/Movie Selector

Macro Focus Button

Menu Control Button

Note: The following is intended as a
basic guide only.  For more specific
information on how to work the
Mavica FD90, refer to the manual
that came with your camera.
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RECORDING MOVING IMAGES

Moving images are recorded in MPEG format

1. Set the PLAY/STILL/MOVIE selector to MOVIE
2. In order to get up to 60 seconds of video you have to set the image size to 160 x 112. 

Go to the Menu, click on File>Image Size and select 160 x 112.  
If you set it to 320x240 the maximum recording time is 15 seconds. 

3. Press and hold the shutter button fully down until you want to stop recording.          
"REC" appears on the screen, and the image and sound are recorded on the floppy disk
Be careful - if you let go of the shutter it will stop recording.

TO VIEW STILL AND MOVING IMAGES

1. Set the PLAY/STILL/MOVIE selector to PLAY.  The last recorded image appears on the screen.  
2. Press on the control button to display the menu bar on the screen.   
3. Select the desired still image or video with the control button and then press the center.

If you want to view the video on your computer, install the software on the CD ROM that came with your Mavica,
put in the floppy disk and click on the JPEG or MPEG file you want to open.  We recommend, however, that you
copy the file to the hard drive and then open it as it is easier to open and view files on a hard drive than on a
disk.  You will need QuickTime to play back an MPEG file.  QuickTime is a movie player program designed by
Apple that allows you to view movies.  It’s already installed on all Macs, but if you don’t have it or if you have a
PC you can download it for free from: http://www.apple.com/quicktime/download  

NOTE: It is possible to perform very simple edits of your mpeg files using a basic editor that is included on your
Mavica CD ROM.  While it won’t give you fancy feature film transitions - it will allow you to cut and paste your
short clips together.

A NOTE ABOUT THE MAVICA, MPEG FILES AND iMovie

Just in case you were thinking “Great - I can shoot some short video clips using the Mavica and then 
import and edit them in iMovie...,”  think again.  We hate to be the bearer of bad news - but you can’t.  
Yes, the Mavica records short movie clips as nifty little MPEG files but iMovie only recognizes DV files. 

There is an upgrade to the freeware QuickTime that you can buy online from Apple for $30.  It’s called 
“QuickTime Pro”, and among other things it enables you to convert QuickTime files into DV Stream files,
(a file that iMovie will import) but - there’s a catch.  Just because you view your MPEG file in the QuickTime
player - it’s not really a QuickTime - it’s an MPEG.  

When you convert your MPEG movie to a DV Stream movie and then import it into iMovie - you won’t get 
any sound.  This is because the MPEG movies have the video and audio on the same track and QuickTime 
has no way to extract the audio and make it a separate track during the conversion process.  This means 
the  audio just disappears.  Apple has said it hopes to change this in future editions of QuickTime but even 
their latest edition, QuickTime 5, hasn’t solved this problem.  It’s not a bug or anything - it’s just a feature for 
which there was never any real need - until fairly recently, and it’s not one easily added.  Perhaps the 
more people that start using digital still cameras that record MPEG’s - the more pressure Apple will be under 
to fix the problem for us; either that, or fingers crossed that iMovie 3 (whenever that release may be) will   
allow us to import MPEG files.

If you don’t mind losing the sound from your movie clip/MPEG file when you import into iMovie and 
you’re happy to add music or narration to mask the silence - then you should go ahead and purchase  
the QuickTime Pro upgrade so you can do this.

Losing sound is NOT a problem in Hyperstudio.  You can import as many MPEG’s into your Hyperstudio 
Project as you like and it will happily play them.

14



USING THE MAVICA CD200

Pop-up Flash

TURNING IT ON

Slide the power switch up to turn on the power.  
A green light turns on.  
Insert a 3” CD-R or RW disc into the drive and close the disc door
(refer to pg.16 of your Mavica CD200 manual).

INITIALIZING A DISC

When you use a new disc you need to first INITIALIZE it using the initialize menu function, before you can use it
(refer to p.18 & 32 of your Mavica CD200 manual for instructions of how to do this).

Shutter

Built in Microphone

Built in Microphone

Disc Cover “OPEN” Lever

Mode Dial

Power Switch

Battery

Accessory Shoe

Lens
Tripod Receptable

Zoom Lever

DC In Jack
(for AC Adapter)

Menu Control Buttons

LCD Backlight Switch

For specific information on how to work
the Mavica CD200, refer to the manual
that came with your camera.

Note: The following is intended as a basic
guide only.  We have not rewritten the
manual but have listed some of the things
you should look out for when using the
Mavica CD200 camera, along with the
relevant page numbers of your camera
manual to refer to for more information. 
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TO RECORD STILL IMAGES

Still images are recorded in JPEG format.  

1. Set the MODE DIAL by turning it to the camera icon.  The camera icon should be next to the 
raised dark grey plastic insert which lies between the Accessory Shoe and the Mode Dial 
(refer to p.20 of your Mavica CD200 manual if you need more information).

2. Press and hold the shutter button halfway down.  The camera adjusts to the right exposure and 
focus and if you press all the way down the image is recorded onto the disc.  You will see the 
word “RECORDING” appear on the LCD screen - once it disappears your image has been 
saved to the disc and you can take your next picture.

NOTE:There are other settings you can use to record still images such as S, A, M, or SCN
For an explanation of these refer to pg.45 of your manual.

If you will be resizing and compressing images afterwards using a program like Photoshop, it is 
possible to record an image as a GIF or TIFF format to avoid the image deteriorating; see p.44 
of manual.

RECORDING MOVING IMAGES

Moving images are recorded in MPEG format

1. Make sure your camera is set to MOVING IMAGE and MPEG MOVIE by following the       
instructions on p.26 of you manual.  Once you’ve checked this, set your camera to the movie 
icon on the MODE DIAL. 

2. Press and hold the shutter button fully down until you want to stop recording.          
"REC" appears on the screen, and the image and sound are recorded on the CD.
Be careful - if you let go of the shutter and press it down again it will stop recording.
The most you can record on a single CD is 4 mins at 160x112, the lowest “IMAGE SIZE” setting;
p.53 of the manual explains how to set the image size. 

The number of still images (jpg’s) or time-based clips (mpeg’s) you can record on a 3” CD varies depending on the
image size you select.  For example, the higher the image size (resolution) the more space it takes up on a disc.
Still images taken at a 1600x1200 fine resolution will fit 132 images on a disc, whereas if standard quality is
selected, you will fit 237 images.  A lower resolution of 640x480 at fine quality would get you around 663 images
on a disc and at standard quality you would get 1300 images.  

Your camera manual has a handy table of these numbers on p.54, along with the amount of mpeg files (seconds)
you can record.  We suggest you photocopy this page and keep it in your camera bag as a reference and to help
you keep a track of how much space you will take up on a CD before you record anything.

PREPARING TO VIEW IMAGES ON A COMPUTER

You will need to use the black plastic adapter ring that came with your camera to view the 3” CD on a computer.
This can prove a little tricky at first - but with a little practise you’ll get the hang of it.  Once you place the CD
inside the ring, use one tab at a time to ease and click the CD into place.  Refer to p.31 of your Mavica CD200
manual to see diagrams showing how to do this.
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FINALIZATION

You need to finalize your CD before you can view any images on a CD ROM drive.  You will not be able to
view anything unless you finalize the CD. Finalization takes up 13MB of space, so try not to do it after you
have taken only a few images unless you need to - it is best to do it after you have taken a batch of images.

To finalize a disc:
1. Set the MODE DIAL to SET UP and select DISC TOOL using the control button arrow keys.
2. Select FINALIZE and then OK using the arrow keys.
3. The camera needs to be kept still during this process or it will not work 

(p.33 of the manual also includes this information).

VIEWING IMAGES USING A COMPUTER

The instructions in the Mavica CD200 manual for viewing images using a computer are extensive and vary
depending on which operating system your computer has and whether your computer has a CD ROM drive, a
CDR/CD-RW drive or a USB connection.  We suggest you find the section which is appropriate to you and read
through it carefully.  Instructions start on p.35.  

The important thing to remember is that if you will be viewing images on a PC/Windows environment which does
not have a USB connection and only a CD-ROM drive, you will need to finalize the CD and use the adapter ring.

If you will be viewing images on a PC/Windows environment which does have a USB connection, you will be
able to use the USB adapter cable that came with the camera (after you install the USB diver on the supplied
SVPD-006 CD, p.38) and you will NOT need to finalize the CD to view images.

If you want to view images on a PC/Windows environment that has a CD-R/CD-RW drive (and not use the USB
adapter), you will NOT need to finalize the CD to view images but you WILL need to install the software
DirectCD that came with the camera (p.36, 41). 

*** A NOTE TO MACINTOSH USERS ***
As Mac users we’re used to always having to do things differently - it comes with the territory of using such a great
machine!  We do not have the option of viewing images on a Macintosh computer by using the USB adapter cable
(p.36) - but that’s ok - we don’t need it.  

FINALIZE your 3” CD, install the driver “Adaptec UDF Volume Access” CD that came with your camera, pop your
3” CD into the adapter ring and view your images (p. 41).    

ERASING A CD

You CANNOT erase a CD-R.  
Whatever information you record on a CD-R is permanent and cannot be deleted/written over.  

You can ONLY erase a disc if it is a CD-RW disc.
To delete information on a CD-RW disc you will need to FORMAT the disc.  
This process takes approximately 7 mins.  

1. Insert the CD-RW disc into your camera.  
2. Set the MODE DIAL to SET UP.
3. Select DISC TOOL and then FORMAT using the arrow keys.

NOTE: Check to make sure there isn’t anything on the disc before formatting it - once you start the process, there’s
no turning back - you’ll loose whatever information you have on the disc.  Refer to p.82 of the manual for more
information.
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GETTING READY TO INTERVIEW

One of the primary skills for doing research for
inquiry-based projects is the ability to conduct an
interview.  A good interview is a type of guided
conversation, in which the interviewer leads the
interviewee in a certain direction, and tries to get the
answers to predetermined questions.  A masterful
interview has something more—an element of
surprise, a revelation, an unexpected connection
between the two participants. 

‘OPEN’ VS. ‘CLOSED’ QUESTIONS
Good interviews start with good questions.
Questions that elicit the stories and information in a
compelling manner are key to good interviews.
“Open “ questions are questions that begin with
“how,” “why,” “describe” and “explain” - the kind of
questions that get people talking. Students
conducting their first interviews often ask
"closed-questions," questions that can be answered
with  yes-or-no answers.  Questions such as  "Do
you think drugs are bad?" or "Are you happy to be at
this school?" will elicit less talking than "What are
your views about drugs?" or “Describe your feelings
about this school"  

ACTIVITY: REPHRASING QUESTIONS
Below is a transcript of a student interviewing a
teacher.  Have your students, either individually or in
small groups, rephrase these questions to be ‘open’:

ACTIVITY: BRAINSTORMING
INTERVIEW QUESTIONS
At EVC, we get the entire class prepared for an
interview, and each student is involved in creating
questions.  In this activity, the whole class will create
one list of 10 questions for interviews on the street. 

Assign the class a topic or have the class brainstorm
and vote so that one topic is chosen.  Each student
should write 3 interview questions on the topic.  Write
all the questions on the board or type them up &
xerox them. Repetitious questions are acceptable if
they are phrased differently.  After all the questions
have been written on the board, read them aloud. 

Ask students to combine similar questions - find
differently worded questions that have the same
ideas, and  cluster them together.  Either as a whole
class or in small groups, have  the students combine
and rephrase the cluster of questions into several
‘open’ questions.  If the  students identify one or two
questions that encompass all their ideas, they can
use those questions instead of combining and
rephrasing the entire cluster.   

Q: Are you a teacher?
A: Yes
Q: Do you like teaching?
A: Yes
Q: Did you ever teach before you came to this   

school?
A: Yes
Q: Did you like school when you were a teenager?
A: No.

Q: When you first started teaching did you imme-   
diately like what you were doing or did you have 
regrets that maybe you should have tried some
thing different that might have made more money 
and did you always want to be a teacher when 
you were in college or did you study many things?

A: Could you repeat the question?

Sometimes students ask questions that are really
several questions rolled into one.  Some are
tempted to ask long, complicated questions that
reveal more about their own ideas about a topic than
bring ideas forth from the interviewee. 

Here is an example of a long confusing question.
Have your students either individually or in small
groups,  rephrase it into several open questions.

One of the primary skills for
doing research for inquiry-based

projects is the ability to
conduct an interview.
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During a subsequent class, the questions will have to
be ordered.  The questions should go from more
general ones at the beginning to more detailed ones
later; questions about problems should precede
questions about solutions, and finally, personal
questions, if asked at all, should be saved for last,
once the  interviewer has established a rapport with
the interviewee.  For example, "what do you think
about the drug problem in New York City? is a good
opening question, rather than  "describe your own
experience with drugs.”   

LEARN TO LISTEN ACTIVELY
The greatest skill of a good interviewer is one that
may not come to mind right away – it is the ability to
listen. The great television interviewers like Bill
Moyers and Barbara Walters always show extreme
interest in their subjects by listening intently.
Everything about one of these skilled interviewers –
the facial expression, their body language, the
position of the chair – conveys the impression of
intense listening. In this way they make the
interviewee feel like talking and they can react
intelligently and sincerely to what their subject says.
They are active listeners - they listen so that they can
respond.

The questions which we carefully prepare before
beginning an interview are really just a departure
point. Often there is no way to anticipate the answer
to a question, so good interviewers learn to think on
their feet. They formulate new questions as they go
along, based on the responses to previous
questions. This type of give and take is interviewing
at its best – a vibrant conversation that the
interviewer guides and directs. This takes practice,
but it is by no means beyond the reach of students;
we have seen many dynamic interviews conducted
by young people. In fact, interviewing can be an
excellent way for students to improve their listening
skills.

difficult for beginners.  At first, many students stare at
their list of questions, terrified of losing their place or
making a mistake. The interviewee feels lost and
confused and may cut the answers to the questions
short because the interviewer doesn’t appear to be
interested.

Making eye contact requires a certain amount of
assertiveness and self-confidence, and conducting
interviews can help students develop these qualities.
In fact, all the interviewing skills – active listening,
preparing good questions, thinking on your feet –
can increase students’ faith in themselves and make
them more active learners.

MAN-ON-THE-STREET INTERVIEWS
One of the most exciting ways to gather research
with the video camera is to conduct  vox-populi or
man-on-the-street interviews. Here information is
collected from chance encounters with people in the
neighborhood who are all asked the same question
or series of questions. Their opinions provide a kind
of Greek chorus, an overview of popular feeling
about an issue or event or even recent history. One
of our most memorable man-on-the-street interviews
was conducted by a class studying World War II.
The student interviewer asked an elderly man what
he remembered about the war; he turned  out to be
an American Jewish veteran whose platoon had
liberated one of  the German concentration camps,
and when he began to talk about his experience
tears came to his eyes. Through his interview the
war came to life for these students in a most
profound and moving way.   

It might seem daunting to take your class onto the
sidewalks with a video camera, but the best advice is
simply to plunge in. Taking the whole class at once
can be difficult, but if you can bring more than one
camera and corral another adult to go along you
should have no problem. Divide the class into crews
of four before you leave the school and be sure each

One of the most exciting ways to
gather research with the video

camera is to conduct  vox-populi
or man-on-the-street interviews.

TIP: Instruct your student interviewers that  
if they don’t understand an interviewee’s answer,
rather than pretending they did, it is better if they
ask the interviewee to explain his or her answer 
in a different way because they didn’t understand
it the first time. Chances are that if n one student
doesn’t understand something, neither will others.

MAKE EYE CONTACT
Nobody likes to talk with someone whose eyes are
wandering. If you don’t look at the person you are
speaking to, he or she will feel you have no interest
in what they are saying, even if you do. Maintaining
eye contact with an interviewee is one of the most
important skills of a good interviewer but it can be
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TIP: When student crews are preparing to shoot
an interview, the director must decide on the type
of shot they want to record before taping begins.
Do they want the interviewer and interviewee to
be sitting or standing? Are they facing each other?
Is the audience looking over the interviewer’s
shoulder,  so that they get a nice close up of the
interviewee if the camera zooms in, but don’t see
the interviewer’s face?  

Alternately, is the interviewer/interviewee facing  
each other so the camera records their profiles,   
but neither are excluded from the shot?  Once 
these decisions are made the director should go 
over shot with the camera operator to ensure they 
are on the same page.

crew knows who will take the roles of camera
operator, director, interviewer and point person. The
director will call the shots and the point person will
approach people to be interviewed. It is important to
go over with the students a protocol for asking
people if they would like to be interviewed: “Hi, we’re
from the local middle school and we’re doing a
project on community gardens. May we ask you a
few questions?” 

As you proceed the groups should rotate crew roles
as we discussed in the earlier section Rotating Crew
Roles, with each group interviewing one or two peo-
ple.  With a class of thirty and one camera this would
be only seven rotations. We have found the process
to be so interesting to students that they don’t mind
watching the other groups, and they learn a lot from
each other’s attempts.

A FEW TIPS FOR SHOOTING THE      
MAN-ON-THE-STREET INTERVIEW:

•  Always use an external microphone if possible     
-your sound will be much better

•  Keep the questions short and simple
•  Don’t use a tripod. This is a journalistic mode, it    
doesn’t matter if the camerawork is a little shaky

•  Try not to shoot against the sky or a very bright 
wall in order to avoid the backlight effect.

SIT-DOWN INTERVIEWS
Interviews for which you have set up an
appointment, perhaps with an expert in the field, or
the principal or a parent, are more controlled and
controllable situations than the vox populi. In this
kind of interview it is best for both the interviewer and
the interviewee to sit down and for the camera to be
on a tripod. A quiet location should be designated
and the subject should be made to feel relaxed and
comfortable.  This kind of interview is much more
conversational than the man-on-the-street variety so
the environment should be conducive to talking and
listening. 

The background is important here. Remember to
avoid the backlighting effect – don’t seat the subject
in front of a window. However, a window to one side,
just out of the shot, might provide a nice natural
lighting effect. Avoid having anything in the
background that might be distracting, such as a clock
or a very strong graphic, unless you have a good
reason to include it. 

One question students often ask is,  “Where should
the interviewee look – at the camera, or at the
interviewer?”   Although either one is acceptable,
generally the audience feels more comfortable if the

subject looks at the interviewer; if the interviewee
looks directly at the camera he appears to be staring
directly into the eyes of the person viewing the tape.
This can be disconcerting and distracting.

To set up so that the subject speaks to the
interviewer, the interviewer should sit close to the
camera but a little to one side. It is important not to
sit too far to the side so that the interviewee is not
shot in profile. Ideally we should see as much of the
interviewee’s face as possible.

How to set up the microphone will depend upon
whether you want to hear the interviewer’s questions
in the final tape. If you do, the interviewer should
hold a microphone and tilt it back and forth as
they speak. If you do not want to preserve the
interviewer’s questions, a lavalier microphone is
ideal. This is a small mic that hooks onto the
interviewee’s lapel and picks up the  voice of that
person very clearly. A lavalier can be purchased
for around a hundred dollars and is a great tool
to add to your equipment list.

When student crews are
preparing to shoot an interview,
the director must decide on the

type of shot they want to 
record before taping begins. 
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STUDENT SAMPLE: 
“INTERVIEWING DO’S AND DON’TS”

• DO make eye contact with your interviewee
• DO make the interviewee feel comfortable
• DO listen carefully
• DO ask follow-up questions when appropriate
• DO ask open-ended questions

• DO NOT read mechanically from your list of inter    
view questions 

• DO NOT chew gum during the interview 
• DO NOT ask closed questions (questions      
answered with a yes or no)

• DO NOT look bored or unexcited
• DO NOT ask  complicated questions that are   
really two or three questions combined.

EVALUATING YOUR INTERVIEWS
Students can greatly improve their interviewing skills
from interviewing each other on videotape and
watching and critiquing the interviews (refer to the
section headed Building Critical Viewing Skills).  

The following is a sample list of interview “Do’s and
Don’ts” that a group of students wrote after viewing
and discussing their interviews. The same activity
could be done after students watch a mock interview
between the teacher and a student where
the teacher purposely exaggerates a lot of poor
interviewing skills.

TYPES OF INTERVIEW SHOTS
There is no one way to shoot an interview, but there
are several kinds of shots that are preferred. As we
mentioned in our previous tip, the important thing is
for the director to decide upon the kind of shot they
want before setting up for the interview and
communicating this to the camera operator. The
worst thing to come away with is a video in which the
camera is swinging back and forth between the
interviewer and the subject or zooming in and out
every time a different person speaks.

SIDE - ANGLE 
In this shot we see both the interviewer and the
interviewee, sitting next to each other. This is a good
shot to use if you want to keep the interviewer’s
questions in the video. Try to frame it so that it is as
tight as possible while still fitting both people into the
frame.

MEDIUM SHOT 
Here we see only the interviewee in a shot that
includes the head and shoulders.  This is the most
commonly used shot in documentary videos and
films.

OVER-THE-SHOULDER
In this shot, most often seen in news programs, the
camera is right behind the interviewer, so that a bit of
the interviewer’s head and shoulder can be seen.

MS: MEDIUM SHOTSIDE - ANGLE
INTERVIEW SET-UP

OVER THE SHOULDER
INTERVIEW SET-UP

COMMON INTERVIEW CAMERA SHOTS

CU: CLOSE UP
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WS: WIDE SHOT

MS: MEDIUM SHOT CU: CLOSE UP ECU: EXTREME CLOSEUP

SIDE ANGLE
INTERVIEW SET-UP

OVER THE SHOULDER
INTERVIEW SET-UP

HIGH ANGLE LOW ANGLE

TWO SHOT

Shot SheetShot Sheet

INTERVIEW SHOTS



CLASSROOM MANAGEMENT
When students have finished shooting, the footage
needs to be viewed & analyzed, ideas shared, and
decisions made as to how the piece will be edited.
Sometimes shy or quieter students have a hard time
pushing their way into a discussion.  To avoid this,
we suggest that the students sit in a circle, or around
a table in their small groups, and do a "go round"
where each student talks in turn about one
small section or "bite" that they really like.  This
encourages full participation, so that the quieter
students don't get lost in a lively discussion of just a
few voices.  In a later go round they can share
ideas for the final project and after those ideas are
discussed, a final go round can take place in which
students can state their preferences, second
choices, etc. in order to come to work out an
agreement with their group members. 

ORGANIZING MULTI TASKS
Video editing is essentially a small-group activity.
When students are putting their projects together at
the computer or video console, the teacher should
organize several other activities so that there aren't
eight children huddled around one station.  In that
kind of a situation it is impossible to keep children on
task.  While 2-3 students are at editing,  students can
work in pairs tackling other tasks:  doing book  and
article research, writing interview questions, creating
related artwork.  Some group members could also
work on their individual writings and reflections, or
text and narration for their projects.  At the end of the
period, the whole group can come back together,
doing a "go round" of what each student
accomplished during the class.

BUILDING CRITICAL VIEWING SKILLS
Unfortunately, good critical skills are not something
you are born with: these skills need to be learned,
and creating multimedia presentations like
Hyperstudio and video productions using iMovie, can
be a good way to teach them.

In our experience, students are initially overly harsh
critics of each other’s work.  Before asking for their
remarks, it is a good idea  remind them that people
take criticism better if they are told positive things
first - for example, “I like the way you spoke,” or,
“Your acting was really convincing.”  Once there has
been some positive response the students can
continue to offer criticism, but in a more constructive
way.  Saying to a classmate, “You looked stupid”
never helped anyone improve.  But a comment like,
“You sound good but you need to sound louder,” is
right on the mark.

The student audience should also critique the crew.
For example, they might suggest to camera operator
that she zoom in or out or pan at certain points, or
that she shoot from a different angle.  They might
also give the rest of the crew feedback, such as
“I couldn’t hear the director” or, “The microphone
was in the shot.”  Offered constructively, their
remarks can improve the look of the shooting and
thereby the overall quality of the scene. 

PUTTING IT ALL TOGETHER:
FINAL STEPS

... good critical skills are
not something you are
born with: these skills
need to be learned...
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RUBRICS, STANDARDS AND 
ASSESSMENT

What is the best method for evaluating
students’ work in media? 
At EVC we have found that the authentic means of
assessment – reflective journal writing, portfolio
round- tables, exhibitions of student work and the
development and use of rubrics – are especially
effective in the appraisal of media-based student
projects.  Unlike a quiz or a paper, a media project is
a complex assignment that progresses over time
and relies heavily upon the development of critical
thinking skills.  As a result, a  project of this sort
can allow for significant growth in the metacognitive
area, helping students to understand how they learn.
But if this is to happen they need more feedback
than a simple grade can give and they need to be
participants in their own evaluation process.

JOURNAL WRITING
Unfortunately, ours is not a reflective culture; most of
us tend to go about our daily affairs with little time set
aside for contemplation. Our schools mirror this
tendency, so that students rarely have the chance
to think what they are learning or about their own
learning processes. Keeping a journal is an excellent
way for students to track and reflect upon their
learning and for teachers to gain insight into their
students during the course of a project; when
the project is completed the journal becomes a
document of how and what they have learned. 

In order for journal writing to work well it requires
practice and ongoing attention from the teacher.  It
is important to set aside a short time each day for the
sharing of journal entries with the entire class, and
for the teacher to read and respond to them on a
regular basis.  Entries should not be graded, as that
can discourage candor on the part of the students;
you want them to be truthful, not   writing what they
think you want to hear. By reading and responding to
journal entries teachers can encourage growth and
anticipate problems before they multiply.

As a practical matter, we have found it works best
to keep journal notebooks in the classroom, in a
folder of each students’ work, and to provide time
during class for writing in them.  This way, no one
leaves their journal at home, and journal writing can
become a habit for the student -perhaps the first
thing they do each day when they come into the
classroom – as well as a means of cultivating
reflective behavior. Likewise, sharing their entries
with their classmates can promote understanding
and collegiality among the students in the class. 

DEVELOPMENT AND USE OF RUBRICS
We have included rubrics for three areas of media
project development with this guide: media
production, interviewing and research skills. Unlike
some rubrics, these are designed around objectives,
activities and outcomes rather than levels of quality
because we wanted to focus broadly on the steps
required for skills development. We have also tied
each of these outcomes to the Middle School English
language Arts standards. An extension of these
rubrics would be to add the qualitative element,
describing levels of quality for each outcome.  As we
mentioned earlier, we like to develop rubrics along
with our students, so that they are participants in the
assessment process. This way, a rubric becomes
part of the instructional strategy - students
understand what is expected of them - and the
distinctions between instruction and evaluation begin
to break down.   

At what point, then, should a rubric be created?
How can students develop an assessment tool
before they have learned the subject matter? One
possibility is to create a series of rubrics as you go
along, after the introduction of specific skills. For
example, after the camera is introduced the students
reiterate what they need to know to operate a
camera, in the form of a rubric. Later, as their skills
improve, they can add higher-level outcomes to the
list. When it comes time for the teacher to give them
a grade, they have a solid understanding of what a
letter grade actually signifies.

Keeping a journal is an
excellent way for students
to track and reflect upon
their learning and for

teachers to gain insight into
their students during the

course of a project

24



PORTFOLIO ROUNDTABLES
At the end of each semester at EVC students must
defend their work to a panel of teachers, parents,
guidance counselors and media producers in the
form of a portfolio roundtable.  It’s impressive to see
these young people standing in front of a group of
adults explaining what and how they have learned;
they back up their statements  with a portfolio of their
writing, storyboards and videotapes, and field difficult
questions about their skills and the form and content
of their projects.  Afterwards, the panel gives them
feedback and suggestions for improvement, and
their instructors talk with them about grading.

The roundtable is the culminating event of a
semester’s worth of project-based learning and is
based upon evidence collected and saved since the
projects inception.  The students prepare for the
roundtables by going over the work they have done
and selecting for the panel items that best
demonstrate the progress they have made.  Thus,
they might screen an early interview and a later one
to show the improvement of their interviewing skills,
or pass around drafts of a script. It is incumbent upon
them to analyze and evaluate their own learning.

Assessment of this nature, while it is more work for
both students and teachers than simply applying a
letter grade, ties evaluation to learning in ways that
are manifestly clear to students. 

EXHIBITION OF STUDENT WORK
One of the most exciting aspects of project-based
work is that it results in a product that can be
exhibited to an audience.  This is perhaps especially
true for media projects which are, after all, created
with the tools of communication.  To create work with
the understanding that it will be presented to an
audience upon completion ties the classroom to the
real world, making learning more meaningful for
students.

When we have screenings of student work at EVC
we take them very seriously and make an effort to
gather a sizable, diverse audience; we invite
parents, school personnel, media producers, funders
and the press.  We also give the students ample
opportunity to answer questions after the screening.
All the student producers stand in front of the
audience after their work is screened and make
themselves available to respond to questions from
the audience.  Answering for themselves in this way
is part of the learning process for these students; as
every teacher understands, you don’t really know if
you know something until you try to explain it to
someone else.

Media projects created in schools can and should be
exhibited for an audience, whether it is the class next
door or the international audience of the  World Wide
Web. The important thing is for students to have
pride in their work and to know that it will be seen by
others.  Students who recognize that they are
making work for an audience, and who have taken
part in shaping the assessment of their projects have
a deep investment in their own learning.

Students who recognize
that they are making work for
an audience, and who have
taken part in shaping the

assessment of their projects
have a deep investment in 

their own learning.
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OBJECTIVE

To understand the    
visual language in 
still images, film   
and television.

To set up a shot for
maximum effect.

To operate a video 
camera with intent.

To care for and    
recharge batteries.

To use a tripod        
correctly and with 
understanding.

To use microphones 
correctly and with 
understanding of the 
technology. 

To work as a member 
of a production team.

To prepare for an edit 
and create an edit 
plan.

To operate a video 
editing system with 
intent.

To understand and  
construct the functions 
of specific multimedia 
and Web software.

ACTIVITY

Students analyze and              
deconstruct films, photos 
and TV clips for shots, 
camera moves, and 
composition.

Students practice setting up  
shots, applying knowledge of 
film language, shot 
composition and lighting.

Students participate in  
hands-on video production 
workshops.

Students receive training in 
the care and recharging of 
batteries 

Students review and practice 
use of tripod.

Students review types of 
microphones and practice 
recording with them.

Students learn crew roles 
and practice rotating them.

Students learn to log video
tape and create a paper edit.

Students learn and practice 
editing techniques and 
esthetics.

Students learn to use multi
media and web software and 
incorporate audio, video and 
still images.

OUTCOME

Students gain a working 
knowledge of film           
language, composition 
and lighting concepts.

Students can effectively      
apply what they know about 
the visual language of    
moving and still images.

Students are able to use a 
video camera independently 
and convey intended effect; 
they demonstrate that they 
know basic camera moves 
and shots. 

Students are able to care for 
batteries and recharge them  
as necessary.

Students know when to use 
a tripod and how to operate 
one correctly.

Students know differences 
between types of micro-
phones, how to use them.

Students understand the 
importance of teamwork and 
are able to assume all     
production roles.

Students understand the 
need for logging and      
planning and can prepare a 
comprehensive paper edit. 

Students can create edited   
videos that exhibit reasoned 
intent in content and compo-
sition and present central 
themes in a concise and 
compelling way.

Students are able to design 
and construct an esthetically 
pleasing, coherent            
multimedia project or     
website. 

STANDARDS

E3d - Student makes  
informed judgments 
about film, TV and  
radio.

E3d - Student makes        
informed judgments 
about film, TV and radio.

E3d - Student makes  
informed judgments 
about film, TV and radio.

E3b – Student 
participates in group     
meetings.

E4e – The student 
demonstrates familiarity 
with functional          
documents, produces 
work.

E2a – The student      
produces a report that   
engages the reader, 
develops a controlling 
idea, creates an    
organizing structure, etc.

E4c – Student reads 
and comprehends 
informational materials;    
produces written or oral   
work.

MEDIA PRODUCTION RUBRIC



OBJECTIVE

To distinguish between  
a good and bad     
interview.

To develop good 
interview questions.

To prepare a 
well-ordered set of       
interview questions. 

To develop good 
interview skills.

To shoot an interview
successfully.

To conduct an in-class
interview.

To conduct a man-on- 
the-street interview.

To conduct an 
interview with an
expert on the interview 
topic.

To critique an 
interview for technical
aspects.

To analyze an 
interview for content.

To log an interview for
editing.

ACTIVITY

Students watch and analyze 
a range of professionally   
produced interviews.
Students review and practice 
use of tripod.

Students study the distinction   
between open-ended and   
closed questions. 

Student analyze their  
interview questions and learn 
to arrange them in a 
meaningful order.

Students practice maintaining  
eye contact, listening,       
handling the microphone and  
speaking clearly.. 

Teacher models and students 
practice three camera 
set-ups: over-the-shoulder, 
two-shot, one-shot.

Students pair up, develop 
interview questions and 
conduct interviews.

Students prepare topical 
questions to ask the public 
and conduct interviews in the 
school neighborhood.

Students locate experts on   
the interview topic, gather 
background information.
Develop questions, set up 
an interview with expert(s).

Students view tapes, noting 
technical aspects.

Students view tapes, noting
informational aspects.

Students view tapes, noting
relevant points.

OUTCOME

Students understand that a 
good interview is a          
conversation about a specific 
subject, conducted with intent.

Students are able to formulate  
open-ended questions and 
follow-up questions. 

Students create a sequence   
of questions moving from    
general to specific and from 
problems to solutions.

Students are able to put an 
interviewee at ease, speak 
clearly and listen carefully to 
answers to questions.

Students are able to direct 
the three camera set-ups and 
understand the purposes of 
each.

Students become adept at 
setting up and using good 
interviewing skills. 

Students gather a range of 
opinions on issues and have 
the experience of conducting 
interviews outside the school.

Students conduct a successful 
interview with at least one 
expert in the field.

Students can critically 
evaluate video footage for 
quality of sound, framing, 
focus, lighting.

Students can evaluate value 
of viewpoints expressed, how 
they relate to evidence. 

Students select segments for 
use in final project.

STANDARDS

E3a – The student   
participates in one-to-
one conferences with     
a teacher, etc.

E1c - Student 
comprehends material,   
produces work.

E4b – Student 
analyzes and revises  
work to clarify and 
make it more effective.

E3a – Student 
participates in one-to-
one conferences with 
a teacher, etc.

E3d - Student makes 
informed judgments 
about film, TV and 
radio.

E3a – Student 
participates in one-to-
one conferences with 
a teacher, etc.

E3a – Student 
participates in one-to-
one conferences with 
a teacher, etc.

E3a – Student 
participates in one-to-
one conferences with 
a teacher, etc.

E3d - Student makes 
informed judgments 
about film, TV and
radio.

E3d - Student makes 
informed judgments 
about film, TV, radio

E4b – Student 
analyzes and revises  
work.

INTERVIEWING RUBRIC



OBJECTIVE
To find personal 
connections to 
research topic. 

To determine topic of 
the project.

To determine audience
for completed project.

To determine objective 
of completed project.

To create a research
agenda.

To conduct 
interview-based 
research.

To conduct research 
using written
documents. 

To conduct research 
for images.

To conduct research 
using the Internet. 

To organize, evaluate 
and summarize 
research data.

To incorporate 
research data into the
project.

ACTIVITY
Teacher facilitates guided 
free-write about 
curriculum-related questions
of interest to students.

Students review questions 
and prioritize to finalize topic
of project.

Students evaluate potential 
audiences for the project.

Students evaluate audience
and topic to determine 
project objective.

Students make a list of 
potential research sources.

Students practice 
interviewing, based on 
Interviewing Skills Rubric.

Students locate relevant 
documents and information 
contained therein.

Students locate sources for
images and determine ways
to import them into project.

Students search for  relevant 
websites and examine them 
for information.

Students use graphic 
organizers and discussions
to synthesize data.

Students create project 
outline with  storyboards,
other graphic organizers. 

OUTCOME
Students develop questions
based on interest and prior 
knowledge and pitch them to
the class.

Students decide what their
project will be about.

Students identify a specific 
audience for the project.

Students can articulate a 
specific objective for their 
project.

Students identify research
sources including interview
subjects, written and visual
documents, media and the
Internet. 

Students are able to conduct 
videotaped interviews that
elicit factual information that  
relates to other evidence 
gathered and that are of a 
high technical quality.

Students gather relevant 
information from written 
documents which is either
quoted or paraphrased. 

Students are able to illustrate 
their project using still images 
from a variety of sources.

Students can find relevant
websites, distinguish credible
sources from unreliable ones
and either quote or paraphrase
them.

Students are able to determine
the most useful aspects of
their data and summarize it.

Students integrate the results
of research into their project.

STANDARDS
E2e - Student 
produces a persuasive 
essay. 

E3b - Participates    
in group meetings.

E1e - Student 
demonstrates 
familiarity with        
functional documents,
produces work.

E3a – Student 
participates in one-to-
one conferences with 
a  teacher, 
paraprofessional or 
adult volunteer.

E1e – Student 
demonstrates 
familiarity with 
functional documents, 
produces work.

E1e – Student 
demonstrates 
familiarity with 
functional documents, 
produces work.

E1d – Student 
demonstrates 
familiarity with a variety  
of public documents, 
produces work.

E1d – Student 
demonstrates 
familiarity with public  
documents.

E1d - same as above

MEDIA PROJECT RESEARCH SKILLS RUBRIC



HYPERSTUDIO
Hyperstudio is a multimedia authoring program. 
It  works and looks a lot like a website in that “buttons”
can added to your working page which once “clicked”
can take you in all sorts of different directions.

Keep in mind therefore, that a Hyperstudio stack is not 
linear like a slide show - it is a good idea to map out your
stack before you begin - much like planning out the
base of an essay or drawing out the route you would
take if you wanted to get from point A to point B. 

Refer to your Hyperstudio manual for more information
on what you can do with this program.

GETTING STARTED

1. Click on New Stack.  Your first card
will automatically appear in the screen.

2. Drag the Tool’s and Color Palettes from 
drop down menu and put to side of screen

TO CREATE A CARD

1. Select New Card from Edit menu
2. Continue adding cards until the stack is complete 

To  move between cards go to the Move menu on 
the above menu bar and select the card you that you wish to go to.

TO SET A BACKGROUND COLOR 

There are two ways to pick a background:
1. Go to Edit > erase background color. Click on the color you want to choose, click OK.

2. Select a color or pattern in the color palette.
Click on the bucket in the tools box and Click on the card.
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TO ADD TEXT

1. Go to Objects > Add a text object
2. Locate the box where you want the text to appear.
3. Click outside the text box in the white area.
4. Select Text Color.
5. Click on Style to select font, size and style.
6. Click OK.
7. Type text.
8. If you don’t want to see a scroll next to the text box or have a text border, make sure that the 

“draw scroll bar”, “scrollable” and “draw frame” boxes are not checked.

ADDING A GRAPHIC

1. Go to Objects menu > Add a graphic object.
2. Select disk file.
3. Draw around picture until flashing red dashes highlight the desired area

4. Click OK.
5. Place picture on card by dragging it,
6. To make changes, select the picture icon from Toolbox and then click on graphic that you want 

changed. 
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ADDING A BUTTON

1. Go to Objects > Add a Button.
2. Choose Type and Color.
3. Type in Name and click OK.

4. Place button on the card and click on the card.  A new window will appear:

5. Select an action and or a place to go (another card or a link). 
6. Click OK.
7. If you chose a place to go pick a transition, change speed to medium, and click OK.
8. To make changes select button shape on toolbox and double click on button on card. 
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TO ADD A VIDEO CLIP

To add a video clip to a card you have to first create a new button and position it.

1. In the Action dialog box, click Play movie or video.

2. In the movie video source choose disk file and press OK.
3. Find a video file in your computer and press open.
4. Position the video in the screen and resize it if necessary and click outside.

NOTE: Movie files must only be run from the computer’s hard drive.  If you have something 
saved on a disk - move it to your hard drive first.  Movie files can be 
Quicktime, MPEG, MOV or AVI format. 

5. Choose from the different options from the QuickTime Movies dialog box and click OK.
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WORKING WITH iMovie
iMovie is video editing software that comes pre-installed on all Apple DV
computers (it can also be purchased separately from Apple for $50).
iMovie uses high-quality "DV" digital video format.  The best thing about it is that
it is a dream to use : you just plug in a compatible DV, miniDV or Digital 8
camcorder and click on an icon to launch the program.  iMovie enables you to
edit digital video, add music, narration or sound effects to your film project's
soundtrack and gives you the choice of adding various transitions between
each of your clips - like the wipes and dissolves we see in films.  iMovie  also
lets you export your film back to tape or save it as a QuickTime file which you
can use in other multimedia programs or use to send in an email over the web.

Apple recently released iMovie 2, which among other things, allows you to split
soundtracks.  Although still a basic editing program - the ease with which
you can use it (ensuring of course, that you have a compatible camera) far
out-numbers it's limitations.  The steps we have included for you below assume
you will be using iMovie 2 and Mac OS 9. They are intended to be a brief
introduction - we recommend you use the iMovie help menu within the program
or consult with an iMovie manual should you require any more information.   

IMPORTING DIGITAL VIDEO FROM A VIDEO CAMERA

1. To import video, connect a fire wire cable from the video camera to the computer.  
2. Point your mouse to the DV camera icon just under the imovie screen         

and select it to import your video.  If all is well the iMovie monitor will turn blue 
and display the words “Camera Connected”.  
If you don’t see  these words - something isn’t right - go over the steps again or trouble 
shoot using the iMovie help menu from within the program. 

3. If you are in camera mode you can now use the computer to control the camera.  
Click on the DV  import icon again when you want to stop importing.

Clip Shelf

Monitor

When you import your footage,
into iMovie, each clip you import
appears on the clip shelf.  The
shelf can hold as many video 
clips  as your drive can capture.  

Camera/Edit Mode

Movie Track
Effects, Transitions, Titles, & Audio Buttons
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EDITING YOUR MOVIE: BUILDING THE MOVIE TRACK 

The movie track
(eye icon) 
is like a 
storyboard.  
Both the first
frame of the 
clip as well as 
it’s length are 
displayed.

Drag the clips from the clip shelf to the onto the movie track at the bottom of the screen in the order that you
want them in your video.  You can change the order at any time by dragging a clip from one part of the Movie
Track and placing it elsewhere — between any two clips, at the beginning of the movie track, or at the end.
On the track, you can delete clips by highlighting them and then hitting "delete" on your keyboard or you can
move them back on the shelf if there is room.

IMPORTING STILLS FROM THE MAVICA

To import JPEG image stills from the Mavica, simply take out the disk from the camera and place it in the disk
drive of the computer.

1. Click on File > Import > File
2. Select the Jpeg image you want to import
3. Click on Import

SPECIAL EFFECTS AND TRANSITIONS
Creating special effects such as making your movie look 
sepia-toned, or giving your clip a watery look, has never 
been easier.  Simply click on effects.

Highlight the portion of the movie track that you want to 
change and then click on the effect.  You can do the same 
with transitions - going from one film clip to another.  
For example,  you can fade in, fade out, dissolve, wipe or 
transition in numerous other ways from one clip to another.

TIP: If you change your mind after you
apply an effect to a clip, or feel you've 
made a mistake, you can magically restore
video clips to their original form using the
“Restore Clip” button. iMovie also has 
multiple levels of  "undo".  This means that
you can go back quite a few steps in the
process and undo things you've done.
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CREATING TEXT AND TITLES

To create titles or longer text pages click on the title button 
under the clip shelf.  Type your titles in the lines that appear 
on the screen and then choose a title style.  Click on “preview”
to see how your title will look.  You can change the color by 
clicking the tiny square marked “color”.  A palette will appear 
with colors to choose from.  Click on your selection.   

You can adjust the size of the letter(s) by dragging and 
clicking the mouse in the area of  the small "A" or large "A."  
If you check the "over black" box your text will be over a solid 
black background. : If you don't check the "over black" box, 
your text will appear superimposed over your video clips. 

If you want to make any changes such as color, letter size, 
speed, etc., make the changes and then click on "update."  
To adjust the speed at which the text effect comes in, adjust
the “speed” and “pause” slides. Don’t forget to click on
“update,” after making the changes. 

When you are ready to include the title in your movie, drag the 
little screen with text from the preview area and place it in the 
Movie Track, where you want the title to appear.  If it is text       
over black, you drag it in front of a clip, or in between two clips.  
If your title is superimposed over video, drag it on top of the clip 
you want it to appear over.  You’ll see the first frame of the title 
in the movie track, just like one of your other clips. 

Shortening a Clip & Inserting a Title or Another 
Clip Inside a Clip

There are several ways in iMovie to shorten a clip.  One way is 
to use the “Split Clip at Playhead” command, which is also used 
to insert another clip or text inside a currently existing clip on your
Movie track.  

1. Click on the clip to select it—click above the 
Scrubber bar. 

2. Drag the playhead along the top of the         
Scrubber bar until you find the spot where 
you want your clip to begin or end, or where 
you  want to insert a title or another clip. 

3. Click on Edit > Split Clip at Playhead. 

Where you had one clip before, you will now see two clips — two separate boxes with the first frame of each
one on the Movie Track. 

TIP: Although many people prefer to 
superimpose their text over video, white
text over a black background has a very
professional look and is a very readable
text in iMovie.

TIP: In order to make titles with fancy
effects such as “flying letters” as readable 
as possible, without having to leave them
on screen for an interminable amount of 
time, try shortening the “speed” slide as
much as possible, and lengthening the
“pause” slide as long as you need so the
title can be read more slowly.
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NARRATION, SOUND EFFECTS AND MUSIC

iMovie, allows you to add music from a CD over the audio 
from your clips, narration, or sound effects.  Click  on “Audio”.
You can then either select “Record Voice”, “Record Music”,
or a specific sound effect.  To select a sound effect, drag it 
from the list down to the track.  As you do this, the Movie
Track converts to a Timeline Track and the audio tracks 
appear.  Place the sound effect on either audio track 1 or 2, 
under the picture where you want the sound effect to be heard.

If you want to record music, drag the playhead in the Timeline 
Track where you want your music to begin.  There are check
boxes on the far right , next to each track, to isolate the track 
you will place your music in.  Put in your CD and find the 
song you want.  When you are ready to record, 
click on “Record Music” and then on the play button.   
While recording, “Record Music” will convert to “Stop.”   
You will see the appropriate track highlighted in yellow as the 
music is recording.  Your music will record until you click on  “Stop.”  

Recording narration is more or less the same process. If you have an
iMac, the computer has a built-in mic above the computer screen.  If
you don’t have a built-in mic, you’ll need to plug in a computer mic in
order to record narration.  The back of every computer, has a mic
input (look for the mic icon).  Place the play head in the Timeline Track
where you want your narration to begin, click “Record Narration” and
begin speaking.  Click on “Stop” when you’re finished.  If you are
having problems recording check your computer settings.  Go to the
apple menu on your desktop (top left hand corner), select Control
Panels > Sound.  Click “input” in the list on the left; and either Built-in
or Internal CD as the device -depending what you are recording.  You
will also need to select your “input source” as either “Built-in Mic”, 
“External Mic” or “Internal CD” from the drop down menu.

EXPORTING YOUR MOVIE

You can export your movie to a digital tape or as a QuickTime.

To transfer it to videotape, set your camera to “VCR” mode, and cue up the tape in your camcorder.
Make sure you use a blank tape so you don’t record over something important !  Accidents do happen. 

Click on File>Export Movie.  Select “Camera” as the “Export  to” option.  To give your movie a clean and 
polished beginning and end, add a few seconds of black before and after the movie.  Once it is on digital
videotape you can dub it to VHS for easy playback.

To export to QuickTime click on File > Export Movie.  
This time select “QuickTime” from the drop down 
menu instead of “Camera”.  This will give you a 
number of “Formats” options.  If you’re planning 
on exporting your movie into a Hyperstudio project 
then select the “Web Movie, Small” option.  This 
compresses it into a smaller file so it takes up less 
memory in your project.  Refer to the iMovie help 
menu for a description of each format and it’s uses.

TIP: Depending on what you will
include, designate   
your tracks for one type of sound.
For instance, if you are having 
music throughout, designate one 
track, track 2 for example,  just    
for music and make track 1 for 
narration and sound effects.  Or,    
if you very little music, then you 
might use track 2 for both music 
and sound effects, and save the 
other track for narration only.

NOTE: If you have an older iBook you may not
be able to find a microphone input.  Mac were
cheap with their earlier models and didn’t put 
one in - what were they thinking!  Thankfully
they’ve corrected this with newer model iBooks.

Educational Video Center’s (EVC) Teacher Development
Department prepared this guide for the New York City 
Board of Education’s Office of Instructional Technology. 
EVC can be reached at:

120 W. 30th Street, 7th Floor, 
NY, NY 10001
(212) 465-9366, ext. 22
www.evc.org                                           
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